ALMA: il ciclo delle acquisizioni: Risorse fisiche
a cura di Libera Marinelli, Delia Pitto, Anna Storace
con la collaborazione di Roberto Brusotti
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A. Ricerche in Alma: vedi esempi
1- Ricerca “Tutti i titoli”: estrae sia record con copie fisiche che quelli senza copie fisiche collegate 
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Facets «

Tipodimateriale v
Libro (34)
Rivista (3)

Tipo dirisorsa v
Altro Seriale - Format...(2)
Libro - Formato fisico (13)
Libro Elettronico (21)

Rivista - Formato elet... (1)

Lingua ~
Inglese (32)

ttaliano (4)

Lingue multiple (1)

Anno di pubblicazione v
1967 -2005 (8)

2006 (4)

2007 (5)

+Altro (3)

Reporte

SCUMA Acquisition:

RIRCCTAAN Parole chiave ~  luxury

Tutti i Titoli (1-20di37)  tuury

#4 Istituzione

Ordinamento principale per : Rilevanza ~

28

2 Community

Ordinamento Secondario per : Rilevanza ~

The exposure of luxury : radical themes in Thackeray / Barbara Hardy

Libro {Libro - Formato fisico) di Hardy, Barbara (London : Owen,
1972)

‘Soggetto: Thackeray, William Makepeace - Critica e interpretazione

® Fisico (1) Elettronico Digitale Altri dettagli

Luxury Travel

Rivista {Altro Seriale - Formato elettronico} (United Kingdom
Haymarket Publishing Services Ltd)

Fisico ® Elettronico (1) Digitale Altri dettagli

Luxury private islands / edited by F. Viadi

Libro {Libro - Formato fisico) di Viadi, Farhad (Kempen : Teneues,
©2006)

Soggetto: Isole

Fisico Elettronico Digitale Altri dettagli

Lingua: Inglese

ISBN: 0-7206-0471-0

Numero record: 000841654

Data aggiornamento: 16/02/2018

Lingua: Inglese

Numero record:
(CKB)1000000000549051

Data aggiornamento: 09/12/2017

Lingua: Lingue multiple
1SBN: 9783832791100

Numero record: 000941840

Tdi2 8/02/2018

Salva Query

Espandi~ @ £

EditaRecord  Holding

EditaRecord  ListaPortfolio =+
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2- Ricerca “Titoli fisici”: Estrae i record che hanno copie fisiche collegate
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Facets « Titoli fisici (1-9di9)  lwxury Salva Query

Tipodimateriale v
Libro (9)

4 Istituzione | 2¢ Community

Tipo dirisorsa v Ordinamento principale per : Rilevanza ~  Ordinamento Secondario per : Rilevanza ~ Espandi~ [ £
Libro - Formato fisico (9)

Lingua v 1 The exposure of luxury : radical themes in Thackeray / Barbara Hardy EditaRecord  Holding
Inglese (7) Libro di Hardy, Barbara (London : Owen, 1972) Lingua: Inglese
Italiano (2) 1SBN: 0-7206-0471-0
Numero record: (OCoLC)848687971
HIDEIEIERTT Data aggiornamento: 18/02/2018
1967-1972 (2) @ Fisico (1) Altri dettagli

1997-2001 (2)
2005-2007 (2)

2008-2016 (3) 2 Luxury and capitalism / Werner Sombart ; introduction by Philip Siegelman EdftaRecord  Holdng
Libro di Sombart, Werner (Ann Arbor : The University of Michigan Lingua: Inglese
Press, ¢1967)

Numero record: (OCoLC)859870301
Data aggiornamento: 16/02/2018

® Fisico (1) Altri dettagli

3 LUXURY : A RICH HISTORY. EditaRecord  Holding =+
Libro di MCNEIL -PETER,-1966- (OXFORD : OXFORD UNIVERSITY Lingua: Inglese
PRESS, 2016) ISBN: 0780199663248
Numero record: 99974966575
Data aggiornamento: 18/02/2018

® Fisico (1) Altri dettagli




3- Ricerca “Copie fisiche”: Estrae  le copie listate una a una
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Facets « Copie fisiche (1-15di 15)  rubaldo merello

aliatepaleConaig #4Istitizione 2 Community

Libro (15)

Bi teca v ‘Ordinamento principale per : Rilevanza ~ Ordinamento Secondario per : Rilevanza ~

‘Sede Architettura (4)

SxtemmrmR([) 1 Rubaldo Merello / a cura di Gianfranco Bruno

Sede Polo Imperia (1) Libro ([S.11 : Iride, 1990) Collocazione: UMER.003 "= Ordi

AE) Barcode: UNIGE00010435 Tipo Collocazione: Altro schema Richieste: 1
Data aggiornamento: 18/02/2018 ‘Status: Non a scaffale

Tipo processo ™ Biblioteca: Sez. DIRAAS - Arte e Spettac. Restituzione: -

In processo (1) Tipo processo: Acquisition technical services (CopyCat) Tipo di materiale: Libro

Tempo di Arrivo Previsto:
A: SCUMA Acquisitions Department
Data di scadenza prenotazione: -

Data di scadenza:

Richiesto entro:

fino a: 28/02/2018

Localizzazione permanente: Prestabile

Alti dettagli

2 Rubaldo Merello / a cura di Gianfranco Bruno

Libro ([S.] - Iride, 1990) Collocazione: E844

Barcode: 00001645 Tipo Collocazione: Altro schema
Data aggiornamento: 18/02/2018 ‘Status: A scaffale

‘Numero di Inventario: PRE2013 22987 Restituzione: -

Biblioteca: Sede Architettura Policy Copia: ZZ-NON USARE MAI !! (ex
o . 04)





Ogni ricerca può essere fatta all’interno della ”Istituzione” o della “Community”. I record della community sono in Marc21.

B. Fornitori
I fornitori sono come in precedenza in Aleph gestiti a livello centrale dal CSSBA.
Sono attualmente presenti in Alma 53 fornitori attivi e 397 inattivi.
Per vedere i fornitori eseguire una ricerca semplice per Fornitore e scorrere la lista, filtrandola per status, oppure ricercare per nome o codice (o meglio Tutto) il fornitore desiderato.
Esempio: ricerca per Tutto=Bozzi
Per vedere i dettagli del fornitore cliccare sul menu Visualizza. La scheda fornitore viene visualizzata sulla pagina Sommario, contenente il codice, il nome, la valuta di fatturazione, le unità d’ordine per cui il fornitore è disponibile, il tipo di fornitore. 
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< Dettagli fornitore Indietro

‘Sommario Informazioni di Conte xc‘ Contatti Informazioni EDI Datiin uso Fauu'e‘ Linee. PO‘ Ccrv.mcazmm‘ AHegax‘ Nc!e‘ Report e statistiche.

Dettagli General Fornitore v

Nome  Nuova P, Bozzi Abbonamenti s.n.c. di Carlo Mangini ¢ Patrizia Nicora

Codice AA-19689 Codice aggiuntivo  AA-NUOVA P BOZZI AB
Godice Sistema B
oe Sistema ID Tassa Nazionale
Staws  Ativo Soggettoad VA No
Valute  EUR Lingua  haliano

Biblioteche  U. ordine CSSBA,U. ordine Scuola Medica-Farm,U. ordine Scuola Politecnica,U. ordine Scuola Scienze,U. ordine Scuola Sociale,U. ordine Scuola Umanistica

Tipo Fornitore 2 Fornitore materiale/Agente Abbonamento | Provider Accesso - Concessore licenza - Goverativo

Account v
& o

Attivo Codice Account Descrizione. Percentuale Sconto Biblioteche

U. ordine Scuola Politecnica U.ordine Scuola Sociale Universita
1 v Aa1%ess Default Account - AA-19689 0.0 di Genova U. ordine CSSBA U ordine Scuola Medica-Farm U -
ordine Scuola Umanistica . ordine Scuola

(DI © Extibn





Cliccando sui …  di fianco alla sezione Account si visualizzano i dettagli dell’account fornitore: sconto praticato, metodo di pagamento, tempi di consegna e sollecito.
Le altre finestre mostrano:
Informazioni di contatto: indirizzi, mail ecc.
Informazioni EDI: solo nel caso sia stato attivato l’EDI per ordini o fatture
Fatture: le fatture collegate al fornitore. NB: attualmente si vedono solo le fatture posteriori alla migrazione, anche se in realtà, da un controllo incrociato in una ricerca per fondo, tutte sono migrate.
Linee d’ordine: chiuse e aperte
Comunicazioni: lo storico dei messaggi inviati al fornitore (ordini inviati manualmente, solleciti automatici)
Allegati: l’elenco dei messaggi in entrata e in uscita (ricevuti da/inviati a).Il testo dei messaggi è visualizzabile e scaricabile dal menu … Visualizza/Scarica (Es. YBP)
Note: le note inserite sul fornitore
Report e statistiche: un grafico riepilogativo dell’andamento del fornitore nell’anno precedente
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Dall’elenco delle Linee d’ordine è possibile passare alla visualizzazione della singola linea d’ordine oppure al pacchetto di ordini che la contiene cliccando sul numero della linea d’ordine oppure sull’ordine
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» < Linee PO (1-20di1.237) Indietro
s 1SBN
2 1D MMS: 990013102050204051 ‘Copie: Sez. DAFIST - Filosofia-Prestabile (1) Nota diricezione:
o Assegnatoa:- Prezzo otale: 11 20 EUR Data invio: 16/02/2017
Tipos Libro @ stempa - Ordine singolo Fondi DAFIST filosofiataliane (100.0%) (FY-2017)
Ondine per: U ordine Scuola Umanistica Fomitore/Account: Nuove P. Bozzi Abbonementis.n.c_ i Carlo
Numero standard: 9788845902345 Mangini « Patizia Nicora / Default Account - AA-19689 AA-19689
Ordine: UMADD0004645-GENSO / (Closed) 1D di Riferimento Fomitore: -
Linea Ordine: UMAO00004645/ (Closec) (Consegna prevista: 18/03/2017
6 12.1: Sermoni De diversis / san Bonaventura ; introduzione, revisione del testo latino, traduzione e note di Massimiliano Lenzi ; revisione dela traduzione  cura di Massimo Eds
‘Tedoldi, Roma, Citta nuova : Nuova collana bonaventuriana, 2017, 9788831194389, ISBN
1D MMS: 990013035630204051 ‘Copie: Sez. DAFIST - Filosofia-Prestabile (1) Nota dircezione:
Assegnatoa:- Prezzo totale: 7200 EUR Data invio: 22/01/2018
Tipos Libro s stamps -Orcine singolo Fondi: BSSU - LETTERE MDS -N.B0ZZI (100.0%) (FY-2018) La copia esiste gia nel Repository
Ondine per: U ordine Scuola Umanistica Fomitore/Account: Nuove P. Bozzi Abbonementis.n.c_ i Carlo
Numero standard: 783831 124380 Mangin « Patizia Nicora / Defaut Account - AA-19689 AA-19689
Ordine: UMADO0D06343-GENSO / (Sent) 1D di Riferimento Fomitore: -
Linea Ordine: UMAO00006343 / (Sent) Consegna prevista: 21/02/2018
7 12.1: Sermoni De diversis / san Bonaventura ; introduzione, revisione del testo latino, traduzione e note di Massimiliano Lenzi ; revisione dela traduzione  cura di Massimo Ed
‘Tedoldi, Roma, Citta nuova : Nuova collana bonaventuriana, 2017, 9788831194389, ISBN
1D MMS: 990013035630204051 ‘Copie: Sez. DAFIST - Filosofia-Prestabile (1) Nota dircezione:
Assegnatoa:- Prezzo otale: 62 40 EUR Data invio: 12/12/2016.
Tipos Libro s stamps -Orcine singolo Fondi DAFIST filosofiatalane (100.0%) (FY-2017)
Ondine per: U ordine Scuola Umanistica Fomitore/Account: Nuove P. Bozzi Abbonementis.n.c_ i Carlo
Numero standard: 783831 124380 Mangin « Patizia Nicora / Defaut Account - AA-19689 AA-19689
Ordine: UMADD0004509-GENSO / (Closed) 10 diRiferimento Fornitore: -
Linea Ordine: UMAO00004509 / (Closec) (Consegna prevista: 11/01/2017
8 16: Formazione e sviluppo dellindividualita / Edith Stein, Roma, Citta Nuova : 0CD, 20 1662 | > lseN e °

1D MMS: 530013365060204051 Cop

‘Sez. DAFIST -Filosofia- Prestabile (1) Nota





Se si clicca invece su Edita si apre la linea d’ordine in editing
NB: E’ importante sottolineare che ordini e solleciti vengono inviati automaticamente dal sistema all’indirizzo e-mail del fornitore. Se il fornitore non ha un indirizzo e-mail valido, l’ordine NON viene inviato.

C. Periodo fiscale, Fondi e Registri (Ledger)
In Alma 2 importanti novità relative ai fondi: Periodo fiscale (Anno contabile) e Registro (General Ledger).
In ogni periodo fiscale c’è di norma un solo ledger (registro). Il registro è un raggruppamento di fondi di un unico periodo fiscale. Teoricamente sarebbero possibili più ledger per periodo fiscale, ma abbiamo scelto di mantenere un registro unico per ciascun anno.

1.Una ricerca generica  per fondo permette di  recuperare tutti i fondi (COAN) presenti in Alma. 
Inizialmente i risultati sono presentati già filtrati per status Attivo e Periodo fiscale 2018. Ci sono 99 fondi attivi appartenenti al periodo fiscale 2018, perché sono stati attribuiti al 2018 tutti i fondi che, pur costituiti in anni precedenti, avevano scadenza 2018.

NB.La prima cosa da fare, una volta a regime con le Acquisizioni, sarà controllare tutti i fondi attivi per ciascuna unità d’ordine, e disattivare quelli non più validi o con saldo disponibile insufficiente
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< Fondi e registri (1-20di 30)
Swwao
Periodo iscale: Y2016

Percorso: GENERAL_LEDGER>ESP - Monografie inglesi Lotto 1

10 BSP - Monografie tedesche Lotto 2 DITEN
Codice: POL-100047/10012017-FUND.
Tipo: Fondo accreditato
Status: Attivo
Periodo Fiscale: FY-2018
Percorso: GENERAL_LEDGER

11 BSP - Monografie tedesche Lotto 2 ING Polo 1
Codice: POL-65312/20161207-FUND
Tipo: Fondo accrediteto
Staws: Attvo
Periodo Fiscale: /Y2018
Percorso: GENERAL_LEDGER

12 BSP - Monografie tedesche Lotto 2 ING Polo 2
Codice: POL70542/15122016-FUND
Tipo: Fondo accrediteto
Statws: Attvo
Periodo Fiscale: /Y2018
Percorso: GENERAL_LEDGER

13 BSP - Monografie tedesche Lotto 2 arch
Codice: POL-66203/15122016-FUND
Tipo: Fondo accrediteto
Staws: Attvo
Periodo Fiscale: /Y2018

Y

Senvizi  Amministatore  Report e statistiche:

Saldo cassa: 923,42 EUR
Saldo impegnato: 000 EUR.
Saldo disponibile: 923,42 EUR

Saldo Accreditato: 251,09 EUR
Bilancio di spesa: 251,09 EUR
Saldo cassa: 0,00 EUR

Saldo impegnato: 0,00 EUR
‘aldo disponibile: 0,00 EUR

Saldo Accreditato: 43696 EUR
Bilancio di spesa: 422,96 EUR
Saldo cassa: 1400 EUR

Saldo impegnato: 0,00 EUR
‘Saldo disponibile: 14,00 EUR

Saldo Accreditato: 31195 EUR
Bilancio di spesa: 311,91 EUR
Saldo cassa: 004 EUR

‘Saldo impegnato: 0,00 EUR
Saldo disponibile: 004 EUR

Saldo Accreditato: 500,00 EUR
Bilancio di spesa: 433,03 EUR
Saldo cassa: | .
saldo impegn

>

it

it

it

it

Dupica

Dupica

Dupica

Dupica





NB2.Un’altra raccomandazione è di concordare con gli amministrativi una forte limitazione dei fondi da utilizzare: p. es. la Biblio di Scienze sociali ha attualmente 46 fondi attivi (2017/2018), la Politecnica 30, ecc.


2.Per vedere tutti i fondi, anche quelli inattivi o appartenenti a un diverso periodo fiscale, rimuovere i filtri applicati  utilizzando il pulsante Pulisci tutto. Vengono presentati 1066 fondi, attivi e non, relativi ai diversi periodi fiscali. Se utilizziamo le faccette a sinistra si possono filtrare e trovare i soli fondi attivi e disponibili per una specifica unità d’ordine 
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Facets »
Status v
Attivo (143)

Inattivo (923)

Tipo v

Fondo accreditato (1037)
Registio (18)
Fondo sommario (11)

Periodo Fiscale v
FY-2018 (118)

FY-2017 (189)

FY-2016 (221)

FY-2015 (122)

+Alto (1)

Registro v
GENERAL_LEDGER (63)
GENERAL_LEDGER (221)
GENERAL _LEDGER (189)
GENERAL_LEDGER (118)
+Alto (1)

Proprietario v
Universita i Gen... (1066)

Disponibile per v
Sede Polo Imperia (3)
Sede Polo La Spezia (13)
Sede Polo Savona (25)

¥

Y

Acquisizioni  Risorse  Servizi  Amministratore  Report e satistiche

20di1.066)

5 PRINT (SALDO)
1042015-FUND

.
EDGERSEDE E SEZ. MED/FAR abbonament 2015

6 PRINT (INTEGRAZIONE 2: MEDICINA NEI SECOLI)

7
EDcER

6 PRINT (INTEGRAZIONE)
1042016-FUND

.
EDcER

INT 2015 DISSAL (SALDO)
072015FUND

Saldo Acereditato: 305,25 EUR
Bilancio i spesa: 0,00 EUR
Saldo cassa: 505,25 EUR
Saldo impegnato: 000 EUR
Saldo disponibile: 805,25 EUR

Saldo Acereditato: 70,00 EUR
Bilancio i spesa: 70,00 EUR
Saldo cassa: 0,00 EUR

Saldo impegnato: 000 EUR
Saldo disponibile: 0,00 EUR

Saldo Acereditato: 500,00 EUR
Bilancio i spesa: 60699 EUR
Saldo cassa: 293,01 EUR
Saldo impegnato: 000 EUR
Saldo disponibile: 23301 EUR

Saldo Aceredil
Bilancio di spe
Saldo cassa: 7202 EUR

Tais

>
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nativ (23) 20.i1.066)
Tipo v R
Fondo accreditato (1037)  [Jl1072015-FUND Saldo Accrediato: 7202 EUR
Registo (16) o Bilancio dispesa: 000 EUR
Fondo sommaio (11) Saldo cassa: 7202 EUR
1 Saldo impegnato: 000 EUR
R v [EDGER>SEDE E SEZ MED/FAR abbonamenti 2015 Saldo disponibile: 72,02 EUR
Fv208 (118)
Fv2017 (189)
FY2016 (221) INT 2015 FAR (SALDO) Edta  Dugles
Fr2ms (122) 1072015FUND Saldo Accreditato: 59568 EUR
+Alo (14) o Bilancio dispesa: 000 EUR
Saldo cassa: 59568 EUR
Regiswro « e Saldo impegnato: 000 EUR
GENERALLEDGER (63) | ||EDGER>SEDE E SEZ MED/FAR abbonamenti 2015 Saldo disponibile: 595,68 EUR
GENERAL_LEDGER (21)
GENERALLEDGER (189) M o0 TRATT 154814 SAVONA s ol
GENERALLEDGER (118) 1052017-FUND Saldo Accreditato: 184,00 EUR
SR o Bilancio dispesa: 000 EUR
- Saldo cassa: 18400 EUR
PEREn e Saldo impegnato: 18400 EUR
UniversitaciGen.. (1066) | oNo TRATTPRIV FRASCONI - SAVONA Saldo disponibile: .00 EUR
Disponibile per v EDGER
‘Sede Polo Imperia (3)
‘Sede Polo La Spezia (13) RDO TRATT 158512-GENOVA I
Sede Polo Savona (28) 1052017-FUND Saldo Accreditato: 79,90 EUR
U. ordine CSSBA (21) o Bilancio di spesa: 0,00 EUR
U.ordine Scuola M... (65) Saldo cassa: 7990 EUR
U.ordne ScuolaPo-. (33) 17 Saldo impegnato: 000 EUR
U.orine ScuolaSei. (19) Mencer Saldo disponibile: 790 EUR
U.ordine Scuola .. (126)
U.ordine Scuola U.. (427) -
e osa017-5uND Saldo Accredi






3.I fondi attivi per l’unità d’ordine Scuola umanistica sono 36, appartenenti a 2 diversi periodi fiscali. Di questi, uno è il registro (General Ledger) attualmente attivo, condiviso con tutte le altre strutture del Sistema Bibliotecario, mentre 35 sono i fondi (COAN) propriamente detti
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Report e statistiche

Saldo Acereditato: 1.000,00 EUR
Bilancio i spesa: 110,40 EUR
Saldo cassa: 589,60 EUR

Saldo impegnato: 19040 EUR
Saldo disponibile: 639,20 EUR

Saldo Acereditato: 13.000,00 EUR
Bilancio i spesa: 574853 EUR
Saldo cassa: 7.25147 EUR
Saldo impegnato: 337546 EUR
Saldo disponibile: 3 872,01 EUR

Saldo Acereditato: 2.000,00 EUR
Bilancio di spesa: 927,29 EUR
Saldo cassa: 1.07271 EUR
Saldo impegnato: 517,15 EUR
Saldo disponibile: 555,56 EUR
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< Fondi e registri (1-1di1)

1

Y sws: Ative

GENERAL_LEDGER
Codice: GENERAL_LEDGER
Tipo: Registro

Status: Attivo

Periodo Fiscale: FY-2018
Percorso:

Acaquisizioni

Risorse

Senvizi

Disponibile per - U. ordine Scucla Umanistica,

Amministratore  Report e statistiche.

Tipo Registro ©  Pulisci Tutto

Saldo Accreditato: 2.611.96325 EUR
Bilancio di spesa: 343.996 92 EUR
Saldo cassa: 2.267.966,33 EUR
‘Saldo impegnato: 42 697,92 EUR
‘saldo disponibile: 2225 268 41 EUR

© AggungiRegisto B

e

© ExLibris Ltd, 2014







[image: image12.png]4]

w Frey Alma % Acquisizioni

< Fondi e registri (1-20 di 35)

s1o0e4

Y Stetus: Attivo ©  Disponibile per - U. ordine Scuola Umanistica

1 BSSU- Continuz. Ita.
Cotice: UMA'S7255/09112017-FUND
Tipo: Fondo accreditato
Status: Ativo
Periodo Fiscale: FY-2018
Percorso: GENERAL LEDGER

2 BSSU-LETTERE AS-N.BOZZI
Cotlice: UMA-27200/14052017-FUND
Tipo: Fondo accreditato
Status: Ativo
Periodo Fiscale: FY-2018
Percorso: GENERAL LEDGER

3 BSSU-LETTEREAS - YBP
Codice: UMA-34334-FUND
Tipo: Fondo accreditato
Status: Attivo
Periodo Fiscale: FY-2018
Percorso: GENERAL_LEDGER

4 BSSU- LETTERE CT - N.BOZZI

—mmeaea LT 0c N Saldo Accradiae conn o0 ELD

¥

Risorse

Senvizi

Y

Amministratore  Report e statistiche.

Tipo  Fondo accreditato @ Pulisci Tutto

Saldo Acereditato: 1.000,00 EUR
Bilancio i spesa: 110,40 EUR
Saldo cassa: 589,60 EUR

Saldo impegnato: 19040 EUR
Saldo disponibile: 639,20 EUR

Saldo Acereditato: 13.000,00 EUR
Bilancio i spesa: 574853 EUR
Saldo cassa: 7.25147 EUR
Saldo impegnato: 337546 EUR
Saldo disponibile: 3 872,01 EUR

Saldo Acereditato: 2.000,00 EUR
Bilancio di spesa: 927,29 EUR
Saldo cassa: 1.07271 EUR
Saldo impegnato: 517,15 EUR
Saldo disponibile: 555,56 EUR
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4.Analisi dei dati di un fondo.
I fondi visualizzati mostrano un breve riepilogo dei dati:
Nome, codice, status (attivo/inattivo), tipo (Fondo/Registro), periodo fiscale, percorso,

Saldo accreditato=Allocated balance (totale accrediti)
Bilancio di spesa=Expenditure balance (totale spese, cioè fatture) 
Saldo cassa=Cash balance (totale accrediti meno le spese, cioè le fatture)
Saldo impegnato=Encumbered balance (totale impegni meno disimpegni, cioè ordini per cui è già stata registrata la fattura). Questo dà la situazione degli ordini effettuati, ma non ancora arrivati
Saldo disponibile=Available balance (totale accrediti meno impegni attivi meno fatture)


5.Per visualizzare i dettagli del fondo cliccare sul nome. 
Si apre in editing la pagina Sommario del fondo.
 E’ possibile disattivare, visualizzare il grafico del fondo, aprire la sezione Regole per:
-prolungare la validità del fondo, per esempio per pagare una fattura oltre la data di validità del fondo (Tolleranza spese fine periodo fiscale) o effettuare un nuovo ordine sul fondo (Tolelranza impegni fine periodo fiscale)

-permettere uno sforamento a livello di impegni (in percentuale) o di spese (in valori assoluti)
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< Dettagli sommario oarna || amute | ([
e -
Nore* [ pssu-LETTERE AS B0z Cosce+ | UMAZ7200/14052017-FUND
Desem Sopareneriea* | Universis i Genova B

Disponibie per | U. ordine Scuola Umanistica .

Descrizione
4
Percorso GENERALLEDGER Tipodifondo | Regolare -
Stes Ativo Velta | Euro -
Periogoiscale | FY-2018 - Date periodofscale  01/01/2018 - 31/1212018
Report: v

Visuslizza report | Bilancio fondo -

Fund Balance

337545

B Ercumberad Baiance
I Alocated Balance
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< Dettagli sommario Disattiva

000
00 |
00 |
1000
ol 3
Balance Type
Balance Type Value In Euro
Alocstes Ssance 1300000
Expended Bance as0702
Gasn Batnce. sa0208
Encumosred Saince 330220
Available Balance fory
Regole v
Eccedenzaimpegno pemessa | No - Spesa el imite consentta | No -
Awiso Percentusle cccedenza impegno | 0.0 Importo awiso eccedenza dispesa | 0.0
Percentusle limite eccedenza impegno | 0.0 Importo imite eccedenza spesa | 0.0
Impegni precegent al priods fiscale | o Spese precedeni s periodo fiscale [ o
(Giomi) (Giomi)
Trasferimentiprecedential periodo [ o Tolleanza per impegni fine Periodo | 19

fscale (Giomi)
Tolleranza Spese fine Periodo fiscale | 159

o)
Rprstnar Informazioni Regale °

fiscale (giomi)




NB: un fondo può essere attivo, ma non utilizzabile a meno che non si aumenti la sua validità

La seconda pagina, Transazioni, permette di vedere in dettaglio le linee di impegno, disimpegno, spesa.
A differenza di Aleph, quando viene pagata una fattura la linea di impegno non si azzera, ma viene creata una corrispondente linea di disimpegno, oltre alla linea per la spesa.
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Codice UMA-27200/14052017-
Saldo impegnato 330226 EUR

Sommario | Transazioni

1-20di1677

Linea PO ~

Y Fiter: Tuto -

Tempo

1 02/02/2018 112017 CET

2 01/02/2018 15:43:49 CET

3 01/02/2018 152535 CET
4 01/02/2018 152535 CET

5 01/02/20181413:16 CET

6 01/02/20181226:45 CET

7 01/02/20181226:45 CET

8 01/02/2018 1226:45 CET

9_01/02/2018 11:32:08 CET

Nmek Allegati

Encumbrance

Expenditure

Disencumbran.

Encumbrance

Encumbrance

Expenditure

Expenditure

Expenditure

Disencumbran.

= GENUAMail

Y

sai0o aispomiore
Saldo Accreditato

Record correlat

Linea PO:POL271
Linea PO:POL268
Lines fattura: PO-6701:(1)

Linea PO:POL268
Linea PO:POL268
Linea PO:POL266

Linea PO:POL263
Lines fattura: 2018/b0zzi3:
)

Linea PO:POL265

Linea fattura: 2018/bozzi3:
)

Linea PO:POL264

Lines fattura: 2018/b0zzi3:
@)

Linea PO:POL265

Report e satistche

1300000 EUR

Importo 3 Data di pagamento
20000
SO00EUR 01/02/2018 154501 CET

S000EUR
S000ELR

1600 EUR

1000EUR 01/02/201812:29:20 CET

1S0EUR 01/02/201812:29:20 CET

10,00 EUR _01/02/2018 12:29:20 CET
163 | >
7500 EUR

Bilancio di spesa

Codice report 3

Alro

alro

alro

Alro

alro

Alro

alro

Trasferiscifondi~  Assegna fondi~





In una linea di Impegno/Disimpegno cliccando sulla linea PO collegata si visualizza l’ordine; in una linea di spesa  si possono visualizzare la linea d’ordine o la linea di fattura
Es. Linea d’ordine
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< Sommario linea PO saiva come empiate || inaevo | ([

7: Atlante dei canzonieri in volgare del Quattrocento / a cura di Andrea Comboni e Tiziano Za.. o
Lines Ordine  UMAD00005253 ordine UMAD00006253-GENSD status Inviato (2018:02:07)
TipoLines  Lioo s stamps - Orcine singolo Ondineper U, orcine Scuola Umanstica Dataimvio  28/11/2017
Ortine
Sommario Descrizione Awmk Linee fattura Linee PO associate z:mvmmcazmmk Utenti interessati Storico. Nmek Allegati

Copie rainate v

o
avloteca Locslizzazione Bsrcoce Dsta i Ricezione Polcy Copia
1 Sez DRAAS- alanistics prestanie 133386210 - 22:NON USARE MA ! (ex 04)
Notsdircezione - Routing curante l icezione. No
Informazioni Fomitore v
Perioco i tolleranza
Fomitore o materisle  Nuova P. Bozzi Abbonamenti s.1.c. diCarlo Mangini € Parizia godoleraras
Nicora/AA-19689/Default Account - AA-19689/AA-19689 wropreatedons
orine (3o
0 cata i Riceuimento
SHmento 8122017
Prezzo v
Prezeo stino 136,00 EUR Prezzoneto 13600 EUR
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< Sommario linea PO

Prezzo

Prezzolistino

[ BSSU- LETTERE AS- N8OZZI (FY-2018) (3 87201 EUR)

Quantita perprezzo 1
Fondi
# Nome fondo
2 Towl -

Dettaglilinez PO,
Metodo i acauisizione

Status della fattura

Codice segnalazione.
Secondaria

Urgente

Limitazione alla
‘cancellazione

Identificativo

Numero riferimento
fornitore

Nota al forntore

Acquisto

Nessuna fattura

No

No

9788884507570

Report e satistche

Prezzo netio

Percento
1000%
1000%

Tipo di materiale

Godice report

Codice segnalazione.
terziaria

Creszione pacehetio
manuale

Nota di limitazione alla
cancellazione

Identificativo Proposto.

Tipo di numero
riferimento fornitore

Numero fattura forntore

cq/action/pageAction.do?xmiFileName=po.poline_summary.xmi&ipageViewMode=View8ipageBean.id

Salva come template

136,00 EUR
00
Importo 4
13600 ELR
Libro
Alro
No

136,00 EUR





Es. Linea di spesa
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EE <)
< Dettagli linea fattura Annulla
2017/295PA o
Numerolinea 00001 Fomitore  AA19689
Dertagiilnea fatura v
Tipo  Regolare Numerolinea 00001
LineaPO  UMAG000USS71
Tiolo  Rinascimento cristano :innovazione e riforma relgiosa nelltaia del quindicesimo @ sedicesimo secolo /Claudio Moreschini
Completamente ;
PrezzoLineaP0  4640EUR e s
Lineefetura della Linea PO Atusle v
AddebtiLinea Fattura v

Prezzo 46,40 EUR
Prezzototale 46,40 EUR
Quantta 1 Noalva -

Codice report

Codice segnalazione. Codice segalazions.
Secondaria terziaria
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< Dettagli linea fattura Annulla
Cosice segnalezione Cosice segnalazione
Secondara eriana
Nota -
Importofeture 46,40 EUR Importotoalelinee
Finanziamento v
°
+ Nome fondo « Percento importo
1 BSSU - LETTERE AS - NBOZZI (FY-2018) (387201 EUR) 1000% 4640ER
2 Todl - 1000% 4540ER
Informazioni relatv alle Linee PO v

Informazioni inea PO view
Numero di Copie
Ordinate 1

Numero di Copie
ficewte 1

Numero di Fatture
esistenti perla Linea PO

Numero di Solleciti 0

ExLibris Lid





Le altre due pagine della scheda Fondo “Note” e “Allegati” permettono di aggiungere o visualizzare note rilevanti al fondo, e di caricare documenti rilevanti per il fondo stesso

6.Aggiungere un fondo
E’ possibile aggiungere un nuovo fondo duplicando un fondo già esistente, oppure partendo dal General ledger->cliccare su Fondi->Aggiungi fondo. (Acquisitions->Fund and ledgers->). Tuttavia se si duplica un fondo alcuni parametri non sono modificabili, se si crea un nuovo fondo a partire dal Ledger si ha maggiore flessibilità.
Per esempio il fondo BSSU – LETTERE INTEGRAZIONE – NUOVA P. BOZZI  (cod. UMA-123456) è stato creato a partire da un altro fondo e duplicandolo.
Il fondo BSSU - LETTERE PROVA 2018 - NUOVA P. BOZZI è stato creato a partire dal registro GENERAL_LEDGER->BSSU - LETTERE PROVA SUM 2018->Aggiungi fondo.

In entrambi i casi il periodo di validità del fondo è predeterminato.

Compilare: Nome, Codice, Appartenente a (selezionare Università di Genova), Disponibile per (selezionare solo l’unità d’ordine che interessa e salvare). La casella Attiva può essere cliccata prima di salvare, in questo caso il fondo viene attivato e salvato
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< Dettagli sommario Elimina | | Attiva Annulla m

BSSU - LETTERE AS - N.BOZZI

Periodo Fiscale Y2018 Saldo disponibile 000EUR Saldo cassa 000 EUR
Codice UMA-27200/14052017- Saldo Accreditato 000EUR Bilancio di spesa 000 EUR
Saldo impegnato 000 EUR
Generale v
Nome * | BSSU - LETTERE INTEGRAZIONE - N.B0ZZI Codice® | UMA-123456
1D Esterno Appartenentea* | Universita di Genova -

Disponibile per | U. ordine Scuola Umanistica -

Descrizione
4
Percorso GENERAL_LEDGER Tipodifondo | Regolare -
St Bozza Vaiwa | Euro -
PeriodoFiscale | FY-2018 - Date periodo fiscale  01/01/2018 - 31/12/2018
Report v

Visualizza report | Bilancio fondo -

T —— i el Do le e o ————




7.Per assegnare una somma a un fondo nella finestra Transazioni cliccare su Assegna fondi, quindi Aggiungi transazione accredito e Salvare
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< Transazioni osanna | [ annuts | [

BSSU - LETTERE INTEGRAZIONE - N.BOZZI (]
Periodo Fiscale Fr2018 Saldo disponibile: 000EUR Saldo cassa 000 EUR
Codice UMA123456 Saldo Acerediato 000EUR Bilancio di spesa 000 EUR
Saldo impegnato 000EUR
Sommario | Transazioni | Note Allegatl
LineaP0 ~ Q

Y Fiter: Tutto +

EUR

Nota della ransazione

‘Aggiungi ransazione Accredito

Ex Libris Lid.





8.Se si effettua una ricerca per fondi attivi 2018 e si filtra tramite le faccette, si vede che i fondi attivi sono ora 100, di cui 1 registro, 95 fondi accreditati (cioè veri e propri fondi dotati di somme allocate e transazioni), e 4 Fondi sommari
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Facets » 20di100)
Staws v O AggiungiRegisto. B &
Ativo (100)

Seriodo Fiscale :FY-2018 & Pulsci Tutto
Tipo v
Fondo accreditato (95)
Registro (1) AEF Genova - RDO 1489674/0RD. 3/20.2.2017 Eda Dulea -
EOEETE (] 122017-FUND. Saldo Accreditato: 9.000,00 EUR
s . o Bilancio di spesa: 502457 EUR
Fv2018 (100) Saldo cassa: 3.97543 EUR

8 Saldo impegnato: 3.172.15 EUR
Registro v o Saldo disponibie: 80328 EUR
GENERAL_LEDGER (100)
Proprietario v AEF Savona - RDO 1489674/0RD. 4/20.2.2017 e Owiea
Universia diGeno.. (100)  022017-FUND Saldo Accreditato: 5.000,00 EUR

° Bilancio di spesa: 274880 EUR
o v Saldo cassa: 2 25120 EUR
U.ordine CSSBA (4) . Saldo impegnato: 70,52 EUR
U-ordine ScuolaMe... (6)  gpgep Saldo disponibile: 218068 EUR
U.ordine Scuola Po...(29)
U.ordine Scuola Scie. (4)
+Alo (3) (GOBI) SCMEF Genova - GARA/ORD. 5/21022017 Eda Dulea -

Saldo Accreditato: 5.000,00 EUR
o Bilancio di spesa: 735,00 EUR
Saldo cassa: 426500 EUR
8 Saldo impegnato: 0,00 EUR
EnGeR Saldo disponibie: 426500 EUR
1as | >
(GOBI) SCMEF Savona - GARA/ORD. 6/21022017 Eda Dulea -
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Se si clicca su Registro si visualizza il General Ledger per il 2018, comprensivo di tutte le somme allocate e tutte le transazioni per tutto il Sistema bibliotecario attribuite all’anno fiscale 2018. 
Editando il General Ledger si vede un grafico riepilogativo di impegni e spese, e spostandosi sulla finestra Fondi si vedono i fondi collegati al General Ledger
[image: image23.png][a] -

@:.";1'\3:‘ Alma * | Acquisizioni Risorse  Servizi

< Fondi e registri (1-1di1)
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Y Stews:Ativo ©  Periodo Fiscale :FY-2018 ©  Tipo: Registro

1 GENERAL_LEDGER
Codice: GENERAL_LEDGER
Tipo: Registro
Status: Attivo
Periodo Fiscale: FY-2018
Percorso:
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Y

Amministratore:

Pulisci Tutto

. @

Report e statistiche

Saldo Accreditato: 2.612.96325 EUR
Bilancio di spesa: 343.996 92 EUR
Saldo cassa: 2.268.966,33 EUR
‘Saldo impegnato: 42 697,92 EUR
‘Saldo disponibile: 2226 268 41 EUR
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< Dettagli sommario Disattiva
Report v

Visualizza report | Bilancio fondo -

Fund Balance

2000,
2s000m |
210000 |
2000 |
20000 |
oo |
§ 100000 | I e sance
2 oon | I Ercumbered Baance
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Per aggiungere un fondo dalla finestra Fondi cliccare su Aggiungi fondo. Si presenta la scelta Fondo sommario/Fondo acrreditato. Se si seleziona Fondo sommario è possibile costituire un budget superiore che raccolga , p. esempio, tutti i fondi 2018 UMA, oppure tutti i fondi 2018 UMA periodici, oppure tutti i fondi UMA creati nel 2018
9.Come avere anche bilanci riepilogativi cumulativi (summary funds)
Posto che abbiamo scelto di avere un unico Ledger per anno fiscale, è possibile creare dei Summary funds (=Budget superiori) per ciascuna unità d’ordine, oppure per particolari tipologie di materiale.  Se si vuole seguire questa strada bisogna:
-A partire dal General ledger aggiungere un nuovo fondo di tipo Summary fund. Il summary fund non avrà somme assegnate, ma erediterà quelle dei suoi fondi.
-a partire dal summary fund aggiungere un nuovo fondo, a cui assegnare le somme, imputare gli ordini, caricare le fatture

In questo modo, partendo dal General Ledger 2018 abbiamo creato il summary fund 
BSSU - LETTERE PROVA SUM 2018  e l’abbiamo attivato, poi a partire da quest’ultimo abbiamo creato un fondo BSSU - LETTERE PROVA 2018 - NUOVA P. BOZZI, a cui abbiamo allocato la somma di 1.500 Euro
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Y Status:Attivo ©  Periodo Fiscale :FY-2018 ©  Pulisci Tutto

1 BSSU- LETTERE PROVA 2018 - NUOVA P BOZZI
Codice: BSSU - LETTERE PROVA 2018 - NUOVA P. 80221
Tipo: Fondo accreditato
Status: Ativo
Periodo Fiscale: FY-2018
Percorso: GENERAL_LEDGER>ESSU - LETTERE PROVA SUM 2018

2 BSSU- LETTERE PROVA SUM 2018
Codice: BSSU - LETTERE PROVA SUM 2018
Tipo: Fondo sommario
Status: Ativo
Periodo Fiscale: FY-2018
Percorso: GENERAL LEDGER
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Saldo Accreditato: 1.500,00 EUR
Bilancio i spesa: 0,00 EUR
Saldo cassa: 1.500,00 EUR
‘Saldo impegnato: 0,00 EUR
‘aldo disponibile: 1.500,00 EUR

Saldo Accreditato: 1.500,00 EUR
Bilancio i spesa: 0,00 EUR
Saldo cassa: 1.500,00 EUR
‘Saldo impegnato: 0,00 EUR
‘aldo disponibile: 1.500,00 EUR
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Si potrebbe seguire questa strada, per esempio, per distinguere i fondi CREATI nel 2018 da quelli creati in precedenza, ma ancora validi nel 2018.

10. Per eliminare un fondo creato per errore bisogna prima disattivarlo. Il fondo non deve avere transazioni attribuite (impegni, Fatture, accrediti … ). Eliminare tutte queste voci quindi disattivare il fondo dai … A questo punto cliccando sui puntini cliccare Elimina (Delete)
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» < Funds List (1-40f4) Deactivate
®  Type: Allocated fund Expenditure Balance: 0.00 EUR
@ saus: cive Gash Balance: 1,000.00 EUR
Fiscal Perod: FY2017 Encumbered Balance:0.00 EUR
Path: LEDGER PROVA Available Balance: 1000.00 EUR
2 FONDO PROVA SCUMA st Duplose
Code: FONDO PROVA SCUMA Allocated Balance: 2.000.00 EUR
Type: Allocated fung Expendiure Balance: 0.00 EUR
Statws: Acte Gash Balance: 2000.00 EUR
Fiscal Priod: FY2017 Encumbered Balance:0.00 EUR
Path: LEDGER PROVA>SUMMARY FUND PROVA SCUMA Available Balance: 2000.00 EUR
3 Fondo prova Periodici SCUMA st Dupleste
Code: FONDO PROVA PERIODICI Allocated Balance: 0.00 EUR o
Type: Allocated fund Expendiure Balance: 0.00 EUR
Status: Inactive ‘Cash Balance: 0.00 EUR Delete
Fiscal Period: FY2017 Encumbered Balance:0.00 EUR Move Fund
Path: LEDGER PROVA>SUMMARY FUND PROVA SCUMA Available Balance: 0.00 EUR
4 SUMMARY FUND PROVA SCUMA st Duplose
Code: SUMMARY FUND PROVA Allocated Balance: 2.000.00 EUR
Type: Summry fund Expendiure Balance: 0.00 EUR
Statws: Actve ‘Gash Balance: 2000.00 ELUR
Fiscal Period: FY2017 Encumbered Balance: 0.00 EUR

Path: LEDGER PROVA Available Balance: 200000 EUR

© ExLibris,





D.Ordine monografie (print)

D1) Ricerca titolo da ordinare
1. Quando si inizia una procedura di acquisizione conviene sempre posizionarsi sul dipartimento delle acquisizioni della propria scuola: in realtà l’ordine lo si può fare anche esternamente ma si arriva ad un punto in cui è necessario collocarsi nel dipartimento pena non riuscire più a vedere il flusso di lavoro della po-line creata

2. Ricercare a catalogo il libro da ordinare con gli strumenti visti all’inizio. Se il libro non è presente bisogna prima creare un record bibliografico derivandolo o aprendo un template di catalogazione e catalogandolo ex novo. A tal fine è stato creato un template OrdineLibroPrint, percorso: Risorse->Apri editor metadata->Template->Unimarc bibliographic->Condiviso). Per creare un nuovo record di acquisizioni selezionare Nuovo: NB: prestare attenzione a NON modificare o eliminare il template
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3. Per ordinare il  volume, una volta visualizzato il titolo da acquistare, cliccare “Ordine” oppure sui puntini a destra … (Edita-Ordina-…) e selezionare “Ordine” nell’elenco delle azioni suggerite
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Se invece si sta partendo da un record non presente, e quindi appena creato col template Acquisizioni, appena salvato il record cliccare sull’icona con il carrello per creare la linea PO
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D2) Scelta tipo ordine e creazione linea PO: compilare i campi indicati qui sotto e creare la linea PO
1- Sull’ordine scegliere il tipo ->Raccomandato. La maschera che si presenta è dinamica, a seconda del tipo di materiale. Per i titoli fisici selezionare “Fisico-Ordine singolo”
2- In Proprietario Linea P.O. Scegliere l’Unità d’ordine
3- Non selezionare Carica da template (no)

4-Non selezionare Assegna inventario manualmente (Vuol dire “non creare automaticamente copia”) 
7-Cliccare su “Crea linea PO”
8.Se compare un Warning di risorsa già presente, selezionare Conferma
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D3) Compilazione della maschera Linea d’ordine. Si apre la maschera linea d’ordine (PO line), aperta nella finestra “Sommario”
1.Associare l’ordine alla library e alla location corrette, selezionando i … a fianco dell’Unità d’ordine e cliccando Edita
2.Modificare Library e location. NB: la collocazione NON si mette qui, ma nella holding
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3. Cliccare su Salva. Compare un messaggio di creazione di una nuova holding, perché è stata cambiata la Library e la Location. Confermare
4. Si ritorna alla maschera della linea d’ordine. Associare il fornitore. ATTENZIONE: E’ SEMPRE INDISPENSABILE ASSOCIARE IL FORNITORE PRIMA DI COMPILARE ALTRI DATI, ALTRIMENTI IL PROGRAMMA NON CARICA CORRETTAMENTE I DATI DI ATTESA PREVISTA DAL RECORD DEL FORNITORE E PARTONO SOLLECITI INCONGRUENTI

5. Associare il fondo (cioè la COAN). Attenzione: cliccando su “Aggiungi Fondo +” si visualizzano solo i Fondi attivi e NON scaduti. Selezionare il fondo opportuno

La maschera presenta già preimpostati il prezzo e la percentuale di addebito fondo
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6.Completare la maschera d’ordine selezionando:
- il METODO DI ACQUISIZIONE:

-- ACQUISTO: in default che implica l’invio di una mail al fornitore


-- ACQUISTA DAL SISTEMA DEL FORNITORE (es Ebsco o Casalini….)
-Il tipo di materiale, il codice Report, e aggiungendo eventualmente una nota al fornitore. 
-la casella Creazione pacchetto manuale
[image: image34.png][N & sicuro | htips//unige.aima.exdibrisgroup.com

w oy Alma Acquisizioni

< Sommario linea PO Modifca Riferimento Bib | | Eimina | | Annulalinea | | Ricollega | | Differisci | | Ordina ora Indietro
B Nome fondo + percento importo &
1 BSSU - LETTERE PROVA 2018~ NUOVA P, BOZZ1 (FY-2018) (1.S0000EUR)  100.0% 3000 R
2 e - 1000% 3000EUR
Dettagllnea PO
Vetodo ai scauiszions | Acquisto Tpodmatersle | Libro
Stetus cellsfatura | Nessuna fura Codioe port | Alto

Codice segnalazione.

~ Processing Claims - Ex L. X | () hitpsi/unigealmaedib: X §

¥

Risorse  Servizi

Report e satistche

Codice segnalazione.

Secondaria terziaria
Urgente Creazon paccherto

Limitazione alla
‘cancellazione
Identificativo

Numero riferimento
fornitore

Nota al forntore

Aggiuntivo

Nota di limitazione alla
cancellazione

Identificativo Proposto.

Tipo di numero
riferimento fornitore

Numero fattura forntore

cq/action/pageAction.do?xmiFileName=po.prerequisite_poline xmiéipageViewMod:

U. ordine Scuola Umanistica - SCUMA Acquisitions Department v

ditBoperation=LOAD&pageBean.id=9913394..





La casella “Creazione pacchetto manuale” va sempre selezionata, anche in caso di ordine singolo, perché solo in questo modo si ha la possibilità di selezionare la biblioteca di consegna materiale. 
L’ordine (PO) è attualmente impostato con Indirizzo di fatturazione della scuola e di spedizione sulla 1 biblioteca in ordine alfabetico (nel caso della BSSU è Sede di Lettere). Quindi se si vuole far arrivare il materiale nel posto giusto è obbligatorio Se invece l’Unità d’ordine che effettua l’ordine desidera che il materiale sia fornito all’indirizzo della Biblioteca di scuola e si tratta di un ordine singolo si può lasciare deselezionata casella.
Anche in caso di acquisto dal sistema del fornitore, per cui non è necessario inserire l’indirizzo di spedizione da Alma è bene creare un pacchetto che permette una procedura manuale e non affidata ai job di Alma….

Completare la creazione dell’ordine selezionando:
-SALVA E CONTINUA se vogliamo far arrivare la mail al fornitore con la segnalazione dell’indirizzo di spedizione (Metodo di acquisizione acquisto). 
-ORDINA ORA se il metodo di acquisizione è la piattaforma del fornitore. Il sistema crea e invia il buono d’ordine.
E’ comunque possibile, anche in caso di acquisto sulla piattaforma del fornitore, selezionare Salva e continua e passare alla creazione del pacchetto manuale. Anche in questo caso non verrà inviata nessuna mail al fornitore

D4. Invio  buono  d’ordine comprendente una o più linee PO con creazione pacchetto manuale

1. Creare una linea d’ordine come in precedenza. Selezionare durante la compilazione “Crea pacchetto manualmente”. Dare “Salva e continua”
Compare un avviso di creazione della linea PO
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2. Aggiungere altre linee d’ordine
3. Dal menu (blu) dei task V in alto a destra a fianco dell’identificativo operatore selezionare “Linee d’ordine-Creazione pacchetto”
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4.Selezionare i titoli che si vogliono ordinare e cliccare su “Crea nuovo PO”

5. Compare il buono d’ordine creato, aperto in editing
Nella sezione Biblioteca selezionare indirizzo di spedizione (cioè di consegna materiale)
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6.Per inviare il buono d’ordine cliccare “Salva e continua”. Se si esegue una nuova ricerca per numero riferimento PO: si vede che il buono d’ordine è stato inviato (status SENT)
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NB: perché l’ordine sia effettivamente inviato il fornitore deve avere un valido indirizzo e-mail, altrimenti la linea d’ordine  rimane in status “Ready” e il PO appena creato  in status “In review”

NB2: se al momento di concludere la creazione della linea d’ordine si è selezionato “Salva” invece che “Salva e continua” si dovranno rivedere gli ordini uno per uno prima di poterli inviare e, per ciascuno, sarà comunque necessario scegliere “Salva e continua”. Le linee d’ordine in questo status (revisione) saranno visualizzabili nel menu Task Ѵ Linee d’ordine – Revisione – Assegnate a te. Per ogni ordine sarà necessario usare l’opzione “Salva e continua”.
7.Se vogliamo vedere cosa è successo al nostro ordine possiamo controllare cosa è arrivato al fornitore:
Dalla barra blu selezioniamo Acquisizioni – Infrastrutture acquisizioni – Fornitori
Cerchiamo il nostro fornitore e selezioniamo visualizza
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Lista Ordini 1710212018

U. ordine Scuola Umanistica
Universita degli Studi di Genova
Biblioteca della Scuola di Scienze Umanistiche

Via Balbi, 119 1 Genova
Genova 16126 16124
ITA

Spett. Nuova P. Bozzi Abbonamenti s.n.c. di Carlo Mangini e Patrizia Nicora

Vorremmo effettuare un ordine delle seguenti copie:

Data ordine: 17/02/2018
Account fornitore: Default Account - AA-19659
Indirizzo di Spedizione: Sede i Lettere Biblioteca della Scuola di Scienze Umanistiche Genova ITA

Metodo di spedizione:
Indirizzo di Fatturazione: Universita degli Studi di Genova Biblioteca della Scuola di Scienze Umanistiche Genova ITA
Numero linea PO Data ISSNISBN Titolo Quantita Prezzo Nota
POL-256 1710272018 Prova ordine libro 1 EUR30.00
Cordiali salut
Dipartimento Acquisizioni

U. ordine Scuola Umanistica

Contattaci: servizi bssu@unige it | Informazioni e orari di apertura: http:/biblioteche unige ithssu | Dove siamo





8. Se invece al momento dell’ordine abbiamo selezionato metodo di acquisizione  “Acquista dal sistema del fornitore”, la procedura è esattamente la stessa, ma in questo caso nessuna lettera verrà spedita al fornitore
D5. Eliminazione di un ordine: prima di eliminare un ordine eliminare le fatture collegate (vedi).
Una volta eliminate le fatture, per eliminare un ordine occorre ricercare il titolo fisico ->cliccare sull’ordine->Dai puntini selezionare Annulla

[image: image40.png]https://unige.alma.exlibrisgroup.com/infra

[ofzd Alma

LineaPo ~
Facets « Seleziona Linea PO (1-1di 1) Indietro
Tipo di acquisto ~ IDMMS ~  9913394559004051 Q
Fisico- Abbona
Fomitore ~
Nuova P, Bozzi Abbo... (1) pa ID MMS: 9913394550004051 Copie: Sez. DIRAAS - Italianistica - Solo Data di rinnovo: 15/12/2018 Modifea R -
Urgente . _ Assegnato consultazione (1) Nota di ricezione: - Vioaifiea Rirerimento 8o
Ng Tipo: Fisico - Abbonamento "'5210“"3'“3“ 0 EUR Data invio: 21/02/2018 Chiudi
on urgente 0 orcine & Fondi: ESSU - LETTERE INTEGRAZIONE -
Grdine per:U.orine Scuola B2 (100.0%) (F2018) s
Biblioteca e Numero standard: Foitore/Account: Nuova P Bozzi
UamlieSE ) Abbonamenti s.n.c. di Carlo Mangini e Patrizia
Ordine: Nicora / Default Account - AA-19689 AA-19689
Attivita v Linea Ordine: 1D di Riferimento Fornito
Non definito (1) for Renewal) Consegna prevista: 23/03/2018

Metodo di acquisizione

©ExLibris Ltd, 2014 2018





Compare un avviso che la copia è stata comunque mantenuta Confermare
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Dal menu Acquisizioni->Elimina PO->inserire il numero di P.O da eliminare
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Cliccare su Monitora processi per verificare la cancellazione del pacchetto
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10. Eliminare una o più copie . Una volta eliminato l’ordine si devono eliminare le copie. 
Ricercare il titolo fisico->dai puntini->Copie->selezionare le copie da eliminare->Azioni->Cancella copie.
Si presenta una richiesta di Lasciare la holding/Eliminare la holding. Selezionare l’azione voluta e conferma
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11. Eliminare un titolo (che non abbia fatture, ordini, copie, holding collegati)
Ricercare in Tutti i titoli il record da eliminare, aprirlo in editing Unimarc->File->Elimina record
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12. Eliminare un record inviato a SBN. Se il record non è condiviso anche da altre istituzioni SBN, quando si elimina il record dal catalogo validare la casella Elimina il record nel Catalogo Centrale. Il record sarà cancellato da Alma e da SBN. NB prima di questa operazione è necessario eliminare le localizzazioni SBN (vedi)
E) Ricezione (arrivo) dell’ordine)

1. Dal menu Acquisizioni-Ricezione e fatturazione-selezionare Ricevi  
Mentre fino a questo punto era possibile agire senza selezionare una particolare unità d’ordine, se clicco su ricevi senza collocarmi non vedo nulla (ma per fortuna Alma avverte che non è stato selezionato nessun dipartimento)
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Se invece mi colloco nel mio SCUMA ACQUISITION DEPARTMENT allora….
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2. Si presenta l’elenco delle linee d’ordine in status inviato (cioè le linee d’ordine in attesa di ricezione) e di quelle in attesa di fattura (cioè già ricevute, ma ancora da fatturare)
Si può scorrere l’elenco, filtrarlo per fornitore, oppure inserire nella casella di ricerca “Ordine singolo” il numero della linea PO o altro criterio (titolo, ecc.)
 3. Selezionare la linea d’ordine che interessa e cliccare su Ricevi in alto a destra.
Attenzione: prima di dare Ricevi selezionare la casella “Tieni in dipartimento” Copy cataloguing per poter completare la catalogazione prima di porre il volume a scaffale. 
In caso avessimo dimenticato di selezionare la casella “Tieni in dipartimento” il libro ordinato risulterà in transito e non presente tra le copie del dipartimento.  In questo caso si può:
- collegarsi al Banco di circolazione opportuno ed eseguire la scansione del barcode della copia, in modo che non risulti più in transito, quindi proseguire con il completamento della catalogazione e l’editing della copia
-oppure, se non si intende procedere immediatamente, cercare la copia fisica, copiare il barcode, andare dal menu “Acquisizioni -> Processi post-ricezione -> scansione copie”, incollare il barcode nella finestra che si apre, e impostare lo stato a “Copy cataloguing”, per aver modo di completare la catalogazione prima che il volume venga richiesto a scaffale

Fatta la ricezione del POL-185, con  il flag “Tieni in dipartimento” il libro risulta in “Copy cataloguing”
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4.Se si cerca nuovamente il titolo fisico a catalogo si vede che: la copia ordinata, pur ricevuta, non è ancora disponibile  e ha una richiesta collegata. L’ordine è “in attesa di fattura” e lo step successivo è “copy cataloging”
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5.Per rendere disponibile la copia appena ricevuta dalla barra blu dei menu selezionare Acquisizioni – Processi post ricezione – Ricezione copie in dipartimento (oppure dall’elenco dei task selezionare: copie in dipartimento). Si presenta la lista di copie in attesa di essere lavorate prima di mandarle allo scaffale: scorrerla o ricercare il titolo che interessa
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6.Sono possibili diverse azioni
- Se clicco sul titolo e poi Edita posso editare il record bibliografico in caso avessi bisogno di aggiornare il record 
- Se clicco sui … Posso selezionare “edita copia inventario”, assegnare un diverso barcode, un numero di ingresso/inventario, e, soprattutto, cancellare il tipo di processo Acquisition technical services. Per farlo basta selezionare la barra bianca che si presenta come ultima riga dall’elenco a tendina. Questa operazione renderà il libro disponibile per l’utenza.
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A questo punto, dopo aver salvato, la copia è disponibile anche se non ha ancora la collocazione
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7.Per aggiungere la collocazione cliccare su Holding ->Edita e inserire la collocazione desiderata, eventualmente modificando il tipo di collocazione.
Posizionati sul campo 852 CTRL+F compilare il sottocampo $h. Se si desidera cambiare il tipo di collocazione (es. Dewey) inserire il codice 1 al posto di 8 come primo indicatore del campo 852
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Naturalmente sarebbe stato anche possibile digitare direttamente all’interno del campo, senza aprire il form.
Salvare il record di holding prima di uscire (cliccare sull’icona col dischetto). A questo punto la copia è disponibile ed ha anche la collocazione

NB: In caso sia necessario cambiare la location, per esempio la copia debba essere spostata da una location prestabile a una solo consultazione, è possibile farlo in questo contesto, sempre modificando la holding. 
8.Il processo Holding/edita copia può essere invertito
F) Fatturazione

1. Dal menu Acquisizioni->Ricezione e fatturazione->selezionare Crea fattura
2.Creare manualmente la fattura inserendo i dati (fornitore, importo fattura, data…).
NB: non selezionare Gestisci ricezione. Al termine della compilazione selezionare Salva e crea linee di fattura
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Si presenta una schermata in cui è possibile eventualmente aggiungere spese di spedizione, sconti, costi generali. Normalmente lasciare invariata questa sezione
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3.Cliccando su Aggiungi riga fattura si apre la lista delle linee d’ordine in attesa di fattura per quel fornitore.
Ricercare la linea d’ordine (o il titolo) che interessa, selezionarlo. Compilare i dati di fattura relativi alla linea d’ordine. 
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La linea di fattura si presenta già precompilata con i dati ricavati dalla linea d’ordine. E’ possibile modificare lo status da “Completamente fatturato” a “Parzialmente fatturato”, aggiungere un altro fondo per il pagamento o modificare il fondo, modificare l’importo della linea di fattura. Se ci sono più linee d’ordine nella fattura selezionare Aggiungi, altrimenti Aggiungi e chiudi. 

4.La fattura passa automaticamente nello status Wayting for payment. Cliccare nuovamente Salva e continua
5.Si apre la lista delle fatture in attesa di pagamento (oppure, se lo si fa in un secondo tempo:. Dal menu Acquisizioni-Ricezione e fatture->selezionare In attesa di pagamento .
Passare alla lista delle fatture Non assegnate
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6. Andare in Edita fattura dai …
Assegnare lo status "Pagato", la data, e compilare il campo "Numero del voucher" . Naturalmente questo campo può contenere il numero di mandato, oppure un numero fittizio. Cliccare Salva e continua
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A questo punto la fattura è pagata e l’ordine risulta chiuso, a meno che l’arrivo e la fattura non siano parziali
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7.NB: Al momento del pagamento la COAN deve essere attiva con validità nell’anno corrente. Se la scadenza è passata compare error. Prima di procedere al pagamento sincerarsi che le COAN (in Alma Fondi) siano attive e con validità corrente. 
Per aumentare la validità di un Fondo dal menu Acquisizioni->Infrastruttura acquisizioni->Fondi e registri, selezionare la COAN voluta, editarla e inserire un numero di giorni di validità oltre la data di scadenza nella sezione Regole->Tolleranza spese fine periodo fiscale, quindi  dare Salva

8. Eliminare una fattura

Ricercare la fattura, dai puntini … Revisiona->Vai a elenco attività->Elimina
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E.Ordine Periodici (print)

E1)Creazione dell’ordine
1. Il flusso è lo stesso degli ordini monografie, ma selezionare tipo ordine “Fisico-Abbonamento”. Generalmente, se il LDR è impostato correttamente, il sistema sente che si tratta di una sottoscrizione e propone la scelta corretta.
 2.Quando si clicca su Crea linea PO e si cerca di cambiare la Library e la Location però si apre direttamente la holding, perché prima di completare l’ordine è necessario:
-modificare la Library e la Location
- assegnare una collocazione
- assegnare un Prediction pattern per quella holding e aprire i fascicoli dell’annata (ma questa operazione può essere fatta anche successivamente, ma comunque nello stesso giorno o nei giorni immediatamente successivi all’invio dell’ordine. Il pattern ben compilato è infatti necessario per la generazione automatica e corretta dei solleciti al fornitore)
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Apriamo il form ed effettuiamo le modifiche, Salviamo cliccando sull’icona del dischetto e diamo Esci
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3.Tornare alla compilazione della linea d’ordine. Nella sezione Fornitore inserire il nome del fornitore.
In questa sezione compaiono alcuni dati precompilati ereditati da quanto presente nel record fornitore:
-Arrivo presunto dopo l’ordine
-Periodo di tolleranza solleciti
Il campo intervallo abbonamento, che compare precompilato con il dato di default 30 gg, indica il periodo di tempo previsto per la ricezione dopo la data di pubblicazione del fascicolo.  Questo dato può essere modificato: in base al dato inserito qui, verrà calcolata la data prevista di arrivo dei fascicoli creati con il  prediction pattern del periodico.

La modifica non ha invece al momento effetto sulla data prevista di evasione dell’ordine. Si veda comunque la sezione Solleciti per una spiegazione più dettagliata delle differenze tra la data di attesa che viene calcolata nella linea d’ordine e la data prevista di arrivo di ciascun fascicolo. 
Compilare i campi rimanenti come per le monografie, ma selezionando questa volta Tipo di materiale Fascicolo e  inserendo i dati di inizio e fine abbonamento, una data di rinnovo precedente alla scadenza, e un periodo di promemoria per il rinnovo. La data di rinnovo serve per la creazione dei rinnovi automatici, il numero di giorni di avviso precedenti la data di rinnovo serve per ricevere gli avvisi di prossima scadenza e per spostare la subscription da rinnovare nell’elenco dei task
Ricordarsi di selezionare “Creazione pacchetto manuale”, quindi dare Salva e continua
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E2. Creazione e invio pacchetto
1.La linea d’ordine è stata creata ed è in stato Creazione pacchetto manuale. 
Dal menu Task->selezionare Linee d’ordine->Creazione pacchetto
Selezionare la linea d’ordine e cliccare su Crea nuovo PO

2.Si apre il PO-6203(buono d’ordine creato) con status In review. E’ possibile editarlo per selezionare un indirizzo di spedizione.
Cliccare su Salva e continua. L’ordine viene inviato
3. L’ordine per un abbonamento è leggermente diverso dall’ordine per una monografia: lo status della PO line non è SENT, ma Wayting for renewal.NOTA BENE: se si sta effettuando un ordine di un abbonamento a un pacchetto o a un portfolio elettronico lo status della PO line è SENT fino a che la risorsa non viene attivata materialmente 
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E3)Creazione del prediction pattern e apertura dei fascicoli per l’anno in corso


L’ordine e la holding per il periodico sono stati creati, ma non c’è ancora nessuna copia fisica disponibile
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Per creare i fascicoli in attesa, e quindi procedere poi alla ricezione è necessario:
- creare materialmente i singoli fascicoli aprendo il Prediction pattern
1.Ricercare il titolo fisico e cliccare Holding-Edita
2. Dal menu Edita selezionare Espandi da template. Selezionare il prediction pattern appropriato, per esempio “monthly regular”
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4.Nel record di holding compaiono 2 nuovi campi Marc21:
-853, che contiene i dati di schedulazione da compilare
-590, che contiene una nota relativa agli stessi dati
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5.Se, posizionati sul campo 853, si usa il tasto F3 (oppure Tools->Marc21 holdings->Next predicted item info), si apre il form per la compilazione. Compilare opportunamente il form e dare Chiudi
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6.Dal menu Tools->Marc21 holdings->Open prediction pattern 
I fascicoli previsti vengono presentati, possiamo salvarli (in  questo modo vengono aperti), oppure cliccare su Cancella e correggere il campo 853 se qualcosa non è corretto
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Il sistema ha calcolato la data di arrivo prevista dei fascicoli in base alla data di pubblicazione del primo fascicolo 01012018, a cui ha aggiunto 10 gg. di intervallo abbonamento.
Trattandosi di un trimestrale ha calcolato la data di pubblicazione degli altri fascicoli, a cui ha aggiunto ugualmente 10 gg. di intervallo abbonamento

7.Prima di salvare la holding correggiamo la nota 590

8.Se adesso ricerchiamo il titolo fisico in Alma –Fisico   vediamo che la colonna disponibilità copie è stata aggiornata con i dati della nostra nuova holding
9.Se visualizziamo le copie connesse a questa holding vediamo che sono stati creati i 4 fascicoli con status “Non a scaffale” tipo processo “Acquisition”.
NB: NON è possibile aprire i fascicoli di annate non comprese nell’ordine/sottoscrizione   
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Attenzione: può capitare che i fascicoli siano presentati con un ordine decrescente; in questo caso selezionare Routine di ordinamento ->Description e invertire l’ordine utilizzando le frecce a destra
Esempi di prediction pattern
Tra i numerosi template disponibili per la creazione dei prediction pattern potrebbe non essere disponibile il template adatto, per esempio in caso di periodici con 5, 8, 11 fascicoli.
In questo caso contattare il CSSBA: verrà predisposto un template apposito.

Generalmente i prediction pattern dei periodici vengono predisposti al momento dell’ordine per il periodico stesso. E’ tuttavia possibile che il responsabile dell’acquisizione demandi al catalogatore la compilazione del prediction pattern, o che sia comunque necessario, durante il ciclo di vita del periodico, modificare la periodicità e quindi il prediction pattern.

Facciamo un esempio per un periodico appena ordinato, ma per cui non è ancora stato creato un prediction pattern

Se apriamo in editing il record di holding vediamo che è stata creata una holding di questo tipo
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Prima di creare il pattern correggiamo il LDR e indichiamo nella pos. 6 Tipo di record “y “ (holding copie periodico).
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Per creare il pattern, posizionati sul campo 852, dal menu Edita->Espandi da template->selezioniamo il template appropriato, per esempio Quarterly months[image: image85.png]~ Navigating the MD Editc X Scheda dettagliata
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Vengono creati 2 nuovi campi, 853 che gestisce la schedulazione, e 590 che è una nota.
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Per impostare correttamente il pattern con i dati del prossimo fascicolo atteso, posizionati sul campo 853, dare F3 e compilare il form che si apre
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Salvare e chiudere. Correggere anche opportunamente la nota 590

Dal menu Strumenti ->Marc21 holdings->Apri copie previste
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Viene presentata l’anteprima dei fascicoli che verranno creati. Se è corretta, dare Salva
[image: image89.png] Navigating the MD Edit= X Scheda dettagliata G google translate - Cerc:

[N & sicuro | htips//unige.aima.exdibrisgroup.com

| Acquisizioni Risorse Servii Amministratore  Report e statistiche

A Parole chiave -

< ndietro

Template > File- Edta-  Stumenti B R R BB [ ] 2 | [esa
Record, ~ | Hai 2 awiso() nel tuo record
&% MARC21 Holdings >

¥ Alfianco della... (2274171280 - . B TR (IS3018 205222 RED)

# A accaoe.. 274221900 || LR p

# i, accido o 27422151 o8

© Aspetii isiopa... (2263348060 005 ) scaffale

4 Bulletin de ... (2265325810( 8528 2 scaftale

# Casmoiaioes. cusol] w8303 L100SRTEN onasctae

¥ Guida ala for.. (2274221960) 590 N N

4 1l mondo degii . (227414970
# Labrogazione d... (224217261
4 La comuzione p...(22742719¢
# La grande guida .. (22547196
# La letieratura . (2246809250
4 Le letterature (2274149560
# Lo fetierature (2274149620

¥ Periodico futur... (227480199~
‘ »

Regole >





Se torniamo ora a visualizzare le copie del periodico, vediamo che sono stati creati 4 nuovi fascicoli
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Editandone 1, ecco come sono stati compilati i dati di numerazione e le date
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NOTA BENE: i prediction pattern, per funzionare correttamente, cioè per creare fascicoli con numerazione e date corrette, devono avere compilati:
-Primo livello numerazione = Volume ($$a): il primo volume atteso
-Secondo livello di numerazione = Fascicolo ($$b): il primo fascicolo atteso
-Primo livello cronologia = Anno ($$i): il primo anno atteso
-Secondo livello cronologia = numero del mese o della stagione del primo fascicolo atteso ($$j): es. 01 per un mensile significa che il primo fascicolo atteso è di gennaio
-Data fascicolo = data del primo fascicolo atteso (non data di arrivo previsto)


In caso manchi, per esempio, la numerazione dei volumi si consiglia di procedere in questo modo:
-inserire nel primo livello di numerazione l’anno

[image: image92.png]Informazioni prossima copia prevista

Primo fivelo di
numerazione(a)
‘Secondo livelo
a 1
numerazione(o)
Primo fivelo di
onoiogiat) 21
‘Secondo livello|
di cronologia)
Patiem di
regolaritaly)
Data Fascicolo 20160101

cancella Chiugi

o1l





Correggere poi il campo 853 indicando nel $$a a. (per anno), invece che v. (per volume).

Correggere opportunamente anche la nota descrittiva 590

[image: image93.png]| Record saivato su 3:19:16 PM. Hai 2 awisof) nel uo record

‘Stai lavorando su - Periodico vecchierel (2274931880004051), Creato da ID200054796 (201031

[ o] T
LDR 00347 ny#a2200097 #4500

008 1011252u###8###4001uueng0000000

8528  $8b CSBASSc CSBAT $8h prova 22

853 0 3 $8aa $8bno. $8u 3 88V r $8i (year) 88] (montn) 8w 88y pmO1,05,09 838 0

590 $8a Published 3 times a year in Jan., May, and Sep. and begins with no.1(2016:Jan.).





Se si aprono le copie previste si vede che vengono create queste copie:
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E4)Arrivo dei fascicoli
1.Dal menu Acquisizioni->Ricezione e fatturazione->Ricevi->Selezionare la lista “In continuazione”  e scorrere la lista o ricercare il titolo per cui si desidera registrare l’arrivo dei fascicoli
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2. Dai puntini …selezionare Gestisci copie. Si apre l’elenco dei fascicoli.
Selezionare il fascicolo che si desidera ricevere e dare Salva e ricevi. Attenzione: Deselezionare la casella Tieni in dipartimento. Se si desidera assegnare il numero di ingresso dai … Edita copia inventario
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Se adesso eseguiamo nuovamente una ricerca per titolo fisico vediamo che il fascicolo è arrivato ed è a scaffale
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E5.Cancellazione dell’arrivo di un fascicolo
Se per errore si è fatto arrivare un fascicolo sbagliato:

1)editare la copia e cancellare data arrivo e operatore ricezione
2)registrare nuovamente l’arrivo del fascicolo sbagliato selezionando Keep in department
3)Dai puntini a destra della copia selezionare unreceive

E6)Pagamento della fattura
1.La fattura si crea come nelle monografie, prima si crea la fattura e poi si aggiungono le singole linee.
In caso di carichi aggiuntivi (domiciliazione):
-se questi vengono pagati sulla stessa COAN del periodico, conteggiarli nell’importo totale e specificarli anche nel dettaglio dei costi aggiuntivi. La casella Usa pro rata ha effetto solo in caso di carichi aggiuntivi per distribuirli su ciascuna linea d’ordine
-se vengono pagati su altra COAN, non calcolarli nell’importo totale e inserire l’importo netto

Dare quindi Salva e continua
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2.Aggiungi riga di fattura:  si presentano nuovi campi da compilare (verifica sovrapposizione date-range date di abbonamento).
Da qui è anche possibile modificare il prezzo (per esempio per effetto dei cambi) e cambiare o aggiungere un ulteriore fondo di addebito, se per esempio fosse necessario separare le spese di domiciliazione dal prezzo del periodico. 
 Selezionare Rilascia impegno residuo in caso l’importo della linea di fattura sia inferiore all’importo della linea d’ordine.
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Quando si finisce di aggiungere l’ultima riga di fattura dare Salva e continua, la fattura è stata creata ed è in attesa di pagamento
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Possiamo vedere che il fondo di addebito ha contabilizzato un disimpegno per l’importo dell’ordine POL-259, e una nuova spesa per l’importo della fattura
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2.Dal menu acquisizioni->Ricezione e Fatture->selezionare In attesa di pagamento.
Editare la fattura e modificare lo status in Pagato, attribuire un numero di voucher ed, eventualmente, modificare la data del voucher.
E7)Solleciti
I solleciti vengono inviati con procedura automatica in base a:
- quanto indicato nella scheda fornitore
- quanto indicato nella linea d’ordine
- le date di attesa fascicoli create tramite il prediction pattern+l’intervallo abbonamento indicato nella linea d’ordine. 

Per gli ordini di monografie (one time physical) per calcolare la data di ricezione prevista viene aggiunto alla data dell’ordine il numero di giorni previsti per l’evasione dell’ordine (arrivo presunto dopo l’ordine) indicato nella linea d’ordine ed ereditato dal record del fornitore. Il sollecito viene generato e inviato automaticamente una volta scaduto il periodo di tolleranza solleciti (claiming grace period).

Per gli ordini di periodici invece la data di ricezione prevista di ciascun fascicolo viene calcolata in base all’expected receiving date di ciascun fascicolo creato con il prediction pattern: data di pubblicazione del fascicolo+ numero di giorni definito nell’intervallo abbonamento. Il sollecito viene generato e inviato una volta scaduto il periodo di tolleranza solleciti, a cui deve essere aggiunto il periodo di tolleranza solleciti.
NB: per i periodici c’è differenza tra la data di attesa indicata nella linea d’ordine e la data di attesa di ciascun fascicolo, calcolata come sopra. La data di attesa indicata nella linea d’ordine, che è dinamica, e si aggiorna man mano che si ricevono i fascicoli, viene presa in considerazione solo in caso il periodico NON sia gestito tramite il prediction pattern
Si veda l’help on line di Alma e il documento Serials: Receiving and Claiming Appendix 1, alla URL https://www.dalnet.org/kb/alma/Appendix1%20to%20Instruction%20Serials%20ordering%20receiving%20claiming%20-%20OCC.docx
The field 'subscription interval' has two purposes:

1. In the order record it is always used to determine the “expected receipt date” as follows:

a. “Expected receipt date” after sending the order but not yet checking in an issue will equal “sent date” + “Expected receipt after ordering (days)”

b. “Expected receipt date” after checking in an issue will equal “Receive date of most recent issue” + “subscription interval”

2. “Future” items will exist only if a prediction pattern is used.  In this case the expected arrival date of the issue (not the order) is the issue date (from 853 field of holding record prediction pattern) + “subscription interval”

Expected receiving date - An item only has its own Expected receiving date if you are using prediction patterns. This field is set by the prediction pattern configuration. When there is a value for this field, the Expected receipt date of the PO line is ignored. Just like the Expected receipt date in the PO line, the PO line is sent to claims after the grace period elapses: Expected receipt date (of the item) + Claiming grace period (of the PO line).

After the grace period, a claim is sent automatically to the vendor, either by EDI or by email, but only the first time this PO line is sent to the Claims page; if an operator updates the PO line's expected receipt date, and the PO line is sent to the Claims page again after the new date, another notification is not sent.

Per il momento contiamo di impostare tutti i fornitori con questi dati:
-arrivo presunto dopo l’ordine: 15
-periodo di tolleranza solleciti: 5
E8)RILEGATURA 
Alla fine dell’anno rilegare i fascicoli in annata

Dalla lista delle copie di un periodico: 
-ricercare il titolo  e cliccare su holding
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Dai puntini a fianco della holding voluta selezionare Visualizza copie
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Selezionare le copie da rilegare e, dal pulsante Azioni, scegliere Rilega copie
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Si apre la finestra di rilegatura->Avanti
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Nella seconda pagina selezionare Crea e Modifica senza indicare alcun ordine di lavoro
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Si apre un avviso di cancellazione dei fascicoli. Dare Conferma. Si apre la scheda di copia del volume. Completare  la compilazione di Numerazione A (numero volume), generare la descrizione (Genera), eventualmente aggiungendo il numero di inventario, quindi dare Salva. Eventuali fascicoli mancanti possono essere segnalati in nota.
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NB: con la rilegatura i singoli fascicoli spariscono. Eventuali note vanno riscritte. Il numero di inventario va attribuito al momento della rilegatura, non sul primo fascicolo. Si mantengono solo i dati dell’annata e il collegamento con l’ordine.


Appendice 1: Come associare una linea PO a una holding creata al di fuori del processo di creazione dell’ordine

1.Ricercare il titolo ordinato. Visualizzare le holding cliccando sul pulsante Holding. Dal menu … selezionare Associa una linea PO
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Appendice 2: procedure Ebsco e Casalini
Ordini Ebsco e Casalini: per il momento inserirli sia sulla piattaforma del fornitore, sia a mano in Alma
Fatture YBP Ebsco: stiamo caricando le fatture relative a ordini presenti in Aleph; per le fatture relative a ordini Alma sarà invece necessario per il momento inserirle manualmente.
Appendice 3:
Creazione ordini per più copie di un singolo volume o per più volumi di una monografia in più volumi
1.Più copie dello stesso libro.
Creare l’ordine come di consueto, ma, dopo aver modificato i dati relativi alla Biblioteca e alla location cliccare sul pulsante “Aggiungi localizzazione”, inserire il numero di copie  e la localizzazione voluta. Se la seconda copia ha lo stesso status di prestabilità selezionare la stessa location delle copie precedenti.
[image: image109.png]nmario  Descrizione  Awisi  Lineefattura  LineePOassociate  Comunicazioni  Utentiinteressati  Storico  Note  Allegati
pie ordinate
© Aggiungi Localizzazione +
Biblioteca Localizzazione Barcode Data di Ricezione|

Numero di Copie da aggiungere *
' ccsea Senvizio biblioteche UNIGE0010708 10/03/2018 B -
 cosea ‘Servizio biblioteche UNIGE00010707 10/03/2018 5

Biblioteche supportate:

Routing durante la icezione

Nota diricezione
Policy Copia

formazioni Fornitore




Nella casella Quantità per prezzo indicare il numero totale di copie da ordinare, nel prezzo di listino indicare il prezzo della singola copia
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Procedere quindi come per un ordine singolo.
Al momento della ricezione, modificare la holding inserendo il dato di collocazione e modificare le copie inserendo i dati di copia (id copia, Descrizione), come spiegato nel manuale “Gestione risorse. Casi”

NB: in caso ci si dimentichi di aggiungere la localizzazione per la seconda copia , e quindi venga creata solo una copia collegata all'ordine, la procedura corretta è:
-correggere la holding inserendo la collocazione
-duplicare la copia, inserendo un numero di copia (2) e nella descrizione "Copia 2". Questa formulazione è obbligatoria
-Inserire uno status di processo "Acquisition technical department", in modo che la copia non risulti già a scaffale
-collegare all'ordine la nuova copia
-far arrivare la prima copia con la procedura Receive delle ACQ, editarla per inserire il numero copia e la descrizione anche nella prima copia
-effettuare la scansione in modo che la prima copia diventi disponibile
-editare la seconda copia aggiungendo la data di arrivo manualmente ed eliminando lo status Acquisition technical department

2.Più volumi (1, 2, 3) di un’opera in più volumi descritta con record unico

Ordinare come se si trattasse di un ordine singolo. Dopo aver modificato la localizzazione cliccare sul pulsante Aggiungi localizzazione e indicare SEMPRE la stessa del primo volume per i volumi 2, 3 ecc. In questo modo verrà creata una unica holding.

Nel campo Quantità per prezzo indicare 1, nel prezzo di listino indicare il prezzo totale. Nella nota al fornitore indicare i volumi desiderati.

Al momento della ricezione, modificare la holding inserendo il dato di collocazione e modificare le copie inserendo i dati di volume (Numerazione A, Descrizione), come spiegato nel manuale “Gestione risorse. Casi”
ESTRATTO CORSO ACQUISIZIONI (ONLINE ONLY)

I. Creazione ordine portfolio elettronico

0. E’ necessario avere preventivamente un fondo attivo a cui imputare l’ordine e un fornitore a cui collegarlo (vedi corso ACQ materiale cartaceo)
1.Ricercare il titolo come portfolio elettronico e cliccare su Ordine. In questo esempio il portfolio era già presente in Institution perché passato da SFX ad Alma, quindi la ricerca è stata effettuata in Institution. Se non fosse stato presente, si sarebbe dovuto cercare in Community.

La ricerca in Community richiede di:

- selezionare la versione corretta dell’interfaccia (quella su cui si ha l’accesso)

- selezionare la tipologia corretta della risorsa (ad es. Banca dati / Rivista), per avere risultati coerenti nella ricerca in Uno per Tutto

Va tenuto presente che se si importa dalla Community un portfolio (cioè un singolo titolo), questo porta con sé la collezione specifica a cui appartiene. Se la collezione non esisteva in Alma, viene creata; se già esisteva, il portfolio viene aggiunto alla collection esistente.
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2.Compilare i dati Tipo acquisto e Proprietario (in questo caso, essendo un periodico, abbiamo selezionato Titolo elettronico – Abbonamento) e cliccare Crea lineaPO PO[image: image112.png]po di linea PO e Proprietario
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3. Compilare il form per la linea d’ordine come da esempio. Selezionare “Creazione pacchetto manuale”. NB: per elettronico CELDES l’IVA viene conteggiata nel prezzo e viene pagata al fornitore sulla stessa COAN
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4. Creare e inviare il pacchetto, cliccando sull’icona del menu Elenco task. Se si è selezionato “Acquista dal sistema del fornitore” nessuna mail verrà spedita al fornitore. E’ comunque necessario completare l’ordine con la creazione del pacchetto.
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5.Selezionare gli ordini da racchiudere nello stesso pacchetto e cliccare su Crea nuovo PO
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6.Selezionare l’indirizzo di spedizione della biblioteca, quindi dare Salva e continua
[image: image118.png]< Sommario PO

INFORMAZIONI PO

Numeropo+ | po-19201

FORNITORE

Fomitore/Account * | Celdes 5.r.L/AA-19016/Default Account

Contatto fornitore

Numero fattura
fonitore

BIBLIOTECA
Indirizzo di

fatturazione della
biblioteca *

Commission Ordine

Prezzototale delle
linee copia

Costototale PO

| empty (nonin lista)

‘Scuola di Scienze mediche e farmaceutiche

1430450 EUR

1430450 EUR

sovacconius | | oo |

Numero 6P \

Indiizzo i
spedizione Bibliteca
Metododi ™ I )
spedizione





7.Con la spedizione del pacchetto la procedura d’ordine è completa: il pacchetto risulta inviato e la linea d’ordine è “Waiting for renewal”
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8.In caso di titoli nuovi (non passati da SFX), non ancora attivati, se l’ordine risulta ancora in status SENT e non waiting for renewal, sarà necessario cliccare su “vai all’elenco attività” e attivare l’ordine
L. Casi particolari
1) abbonamento combinato di 2 titoli, entrambi attivi, ma la fattura ha linea unica:
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Si crea ordine solo sul titolo principale e si ricorda nell’ordine che comprende anche il secondo in Nota al fornitore.
Non è indispensabile creare ordine tecnico per il secondo titolo e collegarlo al primo, ma è comunque opportuno editare il portfolio del secondo titolo e aggiungere una nota interna: per l’anno … compreso nell’abbonamento di: …

M. Arrivo della fattura, registrazione e pagamento


1.Creare la fattura come per un ordine cartaceo (Acquisizioni->Ricezione e fatturazione->Crea fattura)
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2.Compilare i dettagli della fattura: in caso di online only e iva pagata contestualmente al fornitore sulla stessa COAN non scorporare l’IVA e indicare solo il prezzo totale, comprensivo di IVA. 

Salvare e creare le linee di fattura
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Cliccare su Aggiungi riga di fattura
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3.Compilare i dettagli di ciascuna linea di fattura, ricordandosi di validare “Verifica range abbonamento” e di inserire le date relative all’anno (se si tratta dell’anno corrente cliccare su Quest’anno).

Se l’importo della riga di fattura fosse inferiore a quello della linea PO validare la casella “Rilascia impegno residuo”.
Cliccare su Aggiungi e quindi aggiungere le successive linee di fattura.
Alla fine dare “Aggiungi e chiudi”. NB: Il totale delle linee di fattura deve essere uguale al totale della fattura
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4.Dopo aver completato la fattura ricercarla nuovamente tra le fatture in attesa di pagamento dal menu ACQ->ricezione  e fatturazione->In attesa di pagamento, editarla  e pagarla come per il materiale cartaceo
Sede di Medicina
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